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Formation traitement de texte niveau 2 (Word 2010) 
 

L'objectif général de ce module est de créer des tableaux, d'appliquer des styles à des paragraphes, de créer 

table des matières et index automatiques et de réaliser des dessins. 
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1. RÉALISER UN TABLEAU 

Problème :  Je veux rapidement réaliser un tableau simple de 3 colonnes et 4 lignes 

Solution :  Ctrl+N (pour créer un nouveau document Word) > onglet Insertion > dans la zone Tableaux 

cliquer sur Tableau > Insérer un tableau… > Nombre de colonnes : 3 > Nombre de lignes : 4 

> OK 

 Sur la première ligne, dans chacune des cases, saisir les titres des colonnes : NOM / ADRESSE 

/ VILLE (touche Tab pour passer d’une case à l’autre) 

 Dans les trois lignes suivantes saisir les données suivantes : 

SOUROIS 19, rue des Brimbelles SAINT-DIE 

BRUMONT 45, avenue Michot AGEN 

HUREAU 6, impasse Malesan LA BREDE 

  

NB :  Pour insérer un tableau il est aussi possible – et plus rapide – dans l’onglet Insertion et la zone 

Tableaux de cliquer sur Tableau puis de glisser sur les cases blanches pour signifier le 

nombre de lignes et de colonnes nécessaires. 

2. SÉLECTIONNER DIVERS ÉLÉMENTS D’UN TABLEAU 

Problème :  Comment sélectionner une ligne, une colonne, une cellule ou tout le tableau ? 

Solution :  Sélectionner une ligne : se placer à gauche de la ligne à sélectionner  une flèche  

apparaît > cliquer 

 Sélectionner une colonne : se placer légèrement au-dessus d’une colonne de façon à faire 

apparaître une flèche  > cliquer 

 Sélectionner une cellule : se placer dans la cellule, légèrement sur la gauche mais pas sur la 

ligne de séparation > une flèche  apparaît > cliquer 

 Sélectionner tout le tableau : cliquer en haut et à gauche du tableau sur l’icône 

3. INSÉRER DES LIGNES 

Problème :  Je m’aperçois que je veux rajouter une ligne entre celle de SOUROIS et celle de BRUMONT 

et trois lignes à la fin du tableau 

Solution :  Cliquer sur BRUMONT > onglet Disposition > dans la zone Lignes et colonnes, cliquer sur 
Insérer au-dessus 

 Se placer dans la marge à gauche de la nouvelle ligne et cliquer-glisser pour sélectionner 

celle-ci et les lignes de BRUMONT et HUREAU > dans la zone Lignes et colonnes, cliquer 

sur Insérer en dessous 

4. SUPPRIMER UNE LIGNE 

Problème :  Comment supprimer la ligne insérée entre celle de SOUROIS et celle de BRUMONT ? 

Solution :  Sélectionner la ligne à supprimer > Ctrl+X (ou Maj+Suppr ou dans la zone Lignes et 

colonnes, cliquer sur l’icône Supprimer > Supprimer les lignes) 

5. INSÉRER UNE COLONNE 

Problème :  Comment insérer une colonne entre ADRESSE et VILLE pour saisir les codes postaux ? 

Solution :  Sélectionner la colonne VILLE > dans la zone Lignes et colonnes, cliquer sur l’icône Insérer à 

gauche 

 Intituler la nouvelle colonne CODE POSTAL > saisir dans les cellules en dessous : 88100 / 

47000 / 33650 
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6. ADAPTER LA TAILLE DES COLONNES 

Problème :  Certaines colonnes sont trop larges par rapport à leur contenu. Je veux adapter leur largeur. 

Solution :  Cliquer n’importe où dans le tableau > onglet Disposition > dans la zone Taille de la cellule 

> Ajustement automatique > Ajuster automatique du contenu 

7. MODIFIER LA TAILLE D’UNE COLONNE 

Problème :  Comment agrandir la colonne NOM ? 

Solution :  Placer le curseur sur le bord droit d’une cellule de la colonne NOM de façon à faire apparaître 

le signe II > cliquer-glisser vers la droite pour élargir la colonne  

 la colonne ADRESSE est réduite et les informations s’affichent sur deux lignes. Pour y 

remédier sans diminuer la taille de la colonne CODE POSTAL, placer le curseur sur le bord 

droit d’une cellule de la colonne ADRESSE > maintenir la touche Maj enfoncée > cliquer-

glisser vers la droite. 

8. METTRE EN FORME UN TABLEAU 

Problème :  Je veux mettre en forme le tableau. 

Solution :  Onglet Création > dans la zone Styles de tableau, cliquer sur la flèche 

Autres 

 

 Choisir un style de tableau à votre goût. 

 Dans la zone Options de style de tableau, si nécessaire décocher  Colonnes à bandes et 

cocher  Première colonne 

9. CENTRER LE TABLEAU DANS LA PAGE 

Problème :  Le tableau est aligné à gauche. Comment le centrer ? 

Solution :  Sélectionner le tableau > onglet Accueil > dans la zone Paragraphe, cliquer sur l’icône 

Centrer 

10. FUSIONNER DES CELLULES 

Problème :  Comment ajouter un titre en haut de mon tableau ? 

Solution :  Placer le curseur n’importe où sur la première ligne > onglet Disposition > dans la zone 

Lignes et colonnes, cliquer sur Insérer au-dessus 

 Dans la case de gauche de la nouvelle ligne saisir : LISTE DES CLIENTS 

 Sélectionner la première ligne > dans la zone Fusionner, cliquer sur Fusionner > dans la zone 

Alignement, cliquer sur l’icône Centrer 

11. FRACTIONNER UN TABLEAU 

Problème :  Je voudrais séparer le titre du reste du tableau 

Solution :  Cliquer n’importe où dans la deuxième ligne > dans la zone Fusionner, cliquer sur 

Fractionner le tableau. 
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12. MODIFIER UNE CELLULE 

Problème :  Comment modifier la mise en forme de la cellule Liste des clients ? 

Solution :  Cliquer n’importe où dans la cellule Liste des clients > onglet Création > au milieu, dans la 

zone Styles de tableau, cliquer sur la petite flèche à droite de Trame de fond > cliquer sur la 

couleur jaune 

 Clic droit sur la cellule > Bordure et trame… > onglet Bordures 

> Type : Encadrement > Couleur : rouge > largeur : 3 pt > dans 

la zone Aperçu, pour ne pas avoir de bordure à droite et à gauche, 

cliquer sur les deux icônes en bas > OK 

 

 

 

 

 

 

13. TRIER UN TABLEAU 

Problème :  Comment trier par NOM le tableau ? 

Solution :  Cliquer n’importe où dans le tableau du bas > onglet Accueil > dans la zone Paragraphe, 

cliquer sur l’icône Trier        > en bas de la fenêtre Trier, sous Ligne d’en-tête, cocher  Oui 

>  1re clé : NOM > OK > supprimer les lignes sans donnée. 

14. FRACTIONNER UNE CELLULE 

Problème :  BRUMONT dispose de deux adresses à AGEN. Je veux donc fractionner la cellule ADRESSE. 

Solution :  Cliquer dans la cellule comportant l’adresse 45, avenue Michot > onglet Disposition > dans la 

zone Fusionner, cliquer sur Fractionner > Nombre de colonnes : 1 > Nombre de lignes : 2 

> OK > saisir dans la nouvelle cellule : 24, rue de la Poste 

 

 Quitter le document en cours sans l’enregistrer (Ctrl+W > N) 

 Ouvrir le fichier CEPAGES.DOC dans le dossier Base 

15. INSÉRER UN SAUT DE SECTION 

Problème :  Comment insérer un saut de section entre deux parties d’un texte ? 

Solution :  Centrer le titre Les cépages > cliquer avant le D de Définition > onglet Mise en page > dans la 

zone Mise en page, cliquer sur        Sauts de pages > Continu 

NB :  Un saut de section permet d’appliquer deux mises en page différentes à deux parties d’un 

texte. Ainsi, dans un texte de douze pages au format portrait       , pour présenter la page 8 au 

format paysage         , il faut ajouter un saut de section Page suivante avant et après la page 8 

16. CRÉER DES COLONNES 

Problème :  Je veux mettre en page le texte sur deux colonnes 

Solution :  Onglet Mise en page > dans la zone Mise en page, cliquer sur Colonnes > Deux > cliquer à 

nouveau sur Colonnes > Autres colonnes > cocher  Ligne séparatrice > OK 

 Si le résultat ne vous semble pas probant, c’est que le mode d’affichage n’est pas adapté : 

cliquer sur l’icône Page (en bas à gauche) 
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17. INSÉRER UN SAUT DE COLONNE 

Problème :  Je voudrais que Réglementation, au bas de la colonne de gauche de la première page, passe en 

haut de la colonne de droite 

Solution :  Cliquer avant le R du titre Réglementation > Ctrl+Maj+Entrée (ou, dans la zone Mise en 

page : Sauts de pages > Colonne) 

 

 Quitter CEPAGES.DOC sans l’enregistrer 

 Ouvrir le fichier PRODTOUR.DOC dans le dossier Base 

18. RÉGLER LA BORDURE ET LA TRAME 

Problème :  Comment améliorer la présentation du titre en ajoutant une bordure et un fond ? 

Solution :  Sélectionner les trois lignes du titre > onglet Mise en page > dans la zone Arrière-plan de 

page, cliquer sur Bordures de page > Onglet Bordures > Type : Ombre > Largeur : 3/4 pt 

> Onglet Trame de fond > Style : 20 % > OK 

19. INSÉRER UNE NOTE DE BAS DE PAGE 

Problème :  Je veux préciser la source de mes informations en ajoutant une note de bas de page 

Solution :  Chercher l’expression encore aujourd’hui dans le document (Ctrl+F > etc.) 

 Placer le curseur après aujourd’hui > onglet Références > dans la zone Notes de bas de page, 

cliquer sur Insérer une note de bas de page 

 Après le 1, saisir la référence bibliographique suivante :  

TINARD Yves. Le tourisme – Économie et management. Paris : Ediscience international, 2e édition, 1994. 

20. NUMÉROTER AUTOMATIQUEMENT LES PAGES 

Problème :  Comment ajouter rapidement un numéro de page en bas et au centre de chaque page ? 

Solution :  Cliquer n’importe où dans le texte > onglet Insertion > dans la zone En-tête et pied de page, 

cliquer sur Numéros de page > Bas de page > choisir le modèle Carré 3 

21. AJOUTER DES INFORMATIONS EN PIED DE PAGE ET EN EN-TÊTE 

Problème :  Je voudrais indiquer en pied de page le nombre de pages total du document et en en-tête le 

nom du fichier 

Solution :  Si une ligne pointillée surmontée à gauche d’un onglet Pied de page n’apparaît pas, double-

cliquer sur le numéro de page  l’onglet Création s’affiche 

 Cliquer après le numéro de page > saisir une barre oblique : / > (onglet Création) > dans la 

zone Insérer, cliquer sur QuickPart > Champ… > Catégorie : Résumé > Noms de champs : 

NumPages > OK 

 Sélectionner le numéro de page, la barre oblique et le nombre de pages du document 

> formater ces éléments en police Arial et taille 10 (en passant par l’onglet Accueil) 
 

 Onglet Création > dans la zone Navigation, cliquer sur Atteindre l’en-tête > dans la zone 

Insérer, cliquer sur QuickPart > Champ… > Catégorie : Résumé > Noms de champs : 

FileName > Format : Majuscules > OK 

 Cliquer n’importe où dans le texte pour quitter l’en-tête de page. 

NB :  Pour que les champs soient mis à jour à chaque impression : onglet Fichier > dans le bandeau 

à gauche, cliquer sur Options > Affichage > dans la zone Options d’impression, cocher  

Mettre à jour les champs avant l’impression 
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 Si, à l’impression, tout ou partie du  pied de page a disparu, c’est que la position du pied de 

page doit être adaptée : onglet Mise en page > dans la zone Mise en page, cliquer sur Marges 

> Marges personnalisées… > onglet Marges > Bas : 3 cm > onglet Disposition > À partir du 

bord : Pied de page : 2 cm > OK  visualiser le résultat en réalisant un aperçu avant 

impression (Ctrl+F2) 

22. NUMÉROTER AUTOMATIQUEMENT LES TITRES 

Problème :  Comment faire en sorte que les parties (qui seront considérées comme des titres de niveau 1) et 

sous-parties (titres de niveau 2) de mon document aient toutes la même apparence et qu’elles 

soient numérotées automatiquement ? 

Solution :  Onglet Accueil > dans la zone Style, cliquer sur la petite flèche en bas à droite  la fenêtre 

Styles apparaît > en bas à droite, cliquer sur Options > Sélectionnez les styles à afficher : Tous 

les styles > Indiquez l’ordre de tri de la liste : Alphabétique > cocher  Nouveaux documents 

basés sur ce modèle > OK > Fermer la fenêtre Styles 

 Atteindre le titre de la première partie du document (I La vente de produits touristiques...) 

> supprimer le I au début et l’espace qui le suit. 

 Dans la zone Style, cliquez sur la flèche Autres, en bas et à droite de la galerie de styles 

rapides 

 

 

 

 

 Cliquer sur Titre 1 

 Dans la zone Paragraphe, cliquer sur l’icône Liste à plusieurs niveaux 

 Cliquer sur la case 

 

 

 

 Dans la zone Style, dans la galerie de styles rapides, clic droit sur Titre 1 > Mettre à jour Titre 

1 pour correspondre à la sélection 
 

 Atteindre la première sous-partie : 1 Qui peut bénéficier... > supprimer la numérotation > dans la 

zone Style, cliquer sur la petite flèche en bas à droite  la fenêtre Styles apparaît > dans la 

liste des styles, cliquer sur le style Titre 2 (si le style Titre 2 n’apparaît dans la galerie des styles : 

Alt+Ctrl+Maj+S > dans la liste, chercher Titre 2 et cliquer dessus) 

 

 normalement la numérotation 1.1. doit apparaître. Si tel n’est pas le cas, comme 

précédemment, dans la zone Paragraphe, cliquer sur l’icône Liste à plusieurs 

niveaux > cliquer sur la même case que pour le Titre 1 > dans la zone Style, dans la 

galerie de styles rapides, clic droit sur Titre 2 > Mettre à jour Titre 2 pour 

correspondre à la sélection 
 

 Atteindre la deuxième sous-partie : 2. Les possibilités... > supprimer la numérotation 

> appliquer le style Titre 2  la numérotation 1.2. doit apparaître 

 

 Continuer à renuméroter les titres jusqu’à la fin du document, même si cela vous prend du 

temps, sinon vous ne comprendriez pas la suite de l’exercice. Les titres des parties, numérotés 

en chiffres romains, doivent être en style Titre 1. Les titres en chiffres arabes, doivent être en 

style Titre 2. Le titre Exemples de prestations doit être numérotée en style Titre 3 car c’est un 

titre de niveau 3. 
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 Le style Titre 1 peut être affecté aux titres Introduction et Conclusion. Mais pour éviter qu'ils 

comportent une numérotation, dans l’onglet Accueil, dans la zone Paragraphe, cliquer sur 

l’icône Numérotation 

NB :  Il faut en fait utiliser des styles dès que l'on commence à saisir un texte et non pas a posteriori 

comme dans cet exemple. Les titres seront formatés en Titre 1, Titre 2, Titre 3… Le texte doit 

être en style Corps de texte. Le style Normal ne devrait être utilisé que ponctuellement. 

 On peut créer des styles de paragraphe mais aussi de caractères (par exemple pour que toutes 

les citations présentent la même forme) des styles de tableau et des styles de listes, pour les 

énumérations, par exemple. 

23. MODIFIER LA PRÉSENTATION D’UN STYLE 

Problème :  Je ne suis pas satisfait de la mise en forme du style Titre 1. Je voudrais qu’ils soient tous en 

majuscule avec un double soulignement. 

Solution :  Regarder la vidéo à l’URL http://youtu.be/orY1YaLiBVc 

 Sélectionner le titre 1. La vente de produits… (en style Titre 1) > Ctrl+D > onglet Police, 

style et attributs > Soulignement : === (Double) > Effets : Majuscules > OK 

 Clic droit au-dessus du titre modifié > Styles > Mettre à jour Titre 1 pour correspondre à la 

sélection 

 tous les titres de niveau 1 sont désormais en majuscule avec un double soulignement 

NB :  Autre manière de modifier un style : onglet Accueil > dans la zone Style, clic droit sur le style 

à modifier > Modifier > en bas à gauche, pavé Format > Police > etc. 

24. CHANGER L’ORDRE DES PARTIES OU SOUS-PARTIES 

Problème :  Je veux réorganiser mon texte de façon que toute la sous-partie 1.5 La garantie financière 

passe avant 1.4. L’habilitation 

Solution :  Onglet Affichage > dans la zone Affichages document, cliquer sur Plan 

 Cliquer sur la liste déroulante à droite de Afficher le niveau > Niveau 2 

 

 

 

 Cliquer sur 1.5 La garantie financière >  cliquer tout à fait à gauche sur l’icône Monter   

 le Titre 1.5 mais aussi tout le texte qui se trouve en-dessous sont déplacés 

25. RÉALISER UNE TABLE DES MATIÈRES AUTOMATIQUE 

Problème :  Comment réaliser rapidement une table des matières ? 

Solution :  En bas de la fenêtre, à droite, cliquer sur l’icône Page pour revenir en mode d’affichage Page 

 Cliquer à la fin de l’introduction après la culture et le loisir > sauter deux lignes > saisir : Le 

plan adopté sera le suivant : > sauter deux lignes en dessous 

 Onglet Références > à gauche, cliquer sur l’icône Table des matières > en bas, Insérer une 

table des matières… > Général : Formats : Soigné > Afficher les niveaux : 2 > OK 

NB :  Pour modifier le formatage d’une table des matières, il faut modifier le style TM 1 qui 

correspond aux Titre 1, le style TM 2 qui correspond aux Titre 2… 

  

http://youtu.be/orY1YaLiBVc
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26. CHANGER UN TITRE DE NIVEAU 

Problème :  Il me semble que La garantie financière et tout ce qui suit est si important que cela pourrait 

donner lieu à un chapitre. Il faut donc passer La garantie financière en Titre 1  

Solution :  Dans la table des matières créées précédemment, cliquer sur 1.4 La garantie financière 

 Alt+Ctrl+O (pour passer en mode plan) > cliquer sur l’icône Promouvoir 

 La garantie financière est passé en Titre 1 et les numéros des sous-parties ont été adaptés 

27. METTRE À JOUR UNE TABLE DES MATIÈRES 

Problème :  Après une modification des parties et sous-parties, comment mettre à jour la table des 

matières ? 

Solution :  En bas de la fenêtre, à droite, cliquer sur l’icône Page 

 Atteindre la table des matières > clic droit sur la table des matières > Mettre à jour les champs 

> cocher  Mettre à jour toute la table > OK 

28. INSÉRER UN RENVOI 

Problème :  Je veux insérer dans mon document un renvoi vers une autre partie et faire en sorte que ce 

renvoi soit automatiquement mis à jour en cas de modification du document. 

Solution :  Chercher dans le document page XXX > supprimer XXX > onglet Insertion > dans la zone 

Lien, cliquer sur l’icône Renvoi > Catégorie : Titre > Insérer un renvoi à : Numéro de page 

> Pour le titre : 4 Les avantages de la vente... > Pavé Insérer > Fermer 

 Clic (ou Ctrl+clic) sur le numéro inséré (5 normalement)  le titre 4 Les avantages de la 

vente...est atteint 

 Insérer un saut de page (Ctrl+Entrée) juste avant le titre   le titre passe à la page 6 

 Pour faire en sorte que le renvoi et la table des matières soient mis à jour : Ctrl+A > F9 

> cocher  Mettre à jour toute la table > OK 

29. RÉALISER UN DESSIN SIMPLE 

Problème :  Comment ajouter le schéma suivant dans mon document : 

 

 

 

 

 

 

 

 

 

 

 

Solution :  Revenir vers la table des matières > cliquer sur le numéro de page au bout de la ligne 3.1 Le 

processus de commercialisation... de façon à atteindre cette sous-partie > cliquer sous le titre 

 Onglet Insertion > dans la zone Illustrations, cliquer sur l’icône Formes > en bas : Nouvelle 

zone de dessin 

 Onglet Insertion > dans la zone Illustrations, cliquer sur l’icône Formes > sous Formes de 

base, cliquer sur le rectangle 

 

 

 
DISTRIBUTEURS  

CONSOMMATEURS 

PRESTATAIRES DE SERVICES 

PRODUCTEURS 
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 Cliquer-glisser dans le haut de la zone de dessin pour dessiner un rectangle > clic droit sur le 

rectangle > Ajouter du texte > saisir : CONSOMMATEURS > sélectionner ce mot > onglet 

Accueil > modifier comme vous le souhaitez la police et la taille des caractères > centrer le mot 

dans la zone de texte > ajuster éventuellement la taille de la zone de texte en utilisant les 

poignées 

 

 

 

 Onglet Format > utiliser les icônes de la zone Styles de zone de texte pour modifier la couleur 

de remplissage, la couleur du contour, le style de trait. Sous l’onglet Format, dans la zone 

Texte, cliquer sur Dessiner une zone de texte > quelques centimètres sous le rectangle 

CONSOMMATEURS, dessiner un rectangle > saisir : PRESTATAIRES DE SERVICES 

 Sélectionner le mot CONSOMMATEURS dans le rectangle supérieur > onglet Accueil > dans la 

zone Presse-papiers, cliquer sur l’icône Reproduire la mise en forme > sélectionner 

PRESTATAIRES DE SERVICES  la mise en forme du texte est copiée 

 Cliquer sur le bord du rectangle CONSOMMATEURS de manière à le sélectionner > icône 

Reproduire la mise en forme > cliquer sur le bord du rectangle PRESTATAIRES DE SERVICES 

 la mise en forme est copiée 

 Tout en maintenant la touche Ctrl enfoncée, cliquer sur le bord des deux rectangles créés de 

manière à les sélectionner > onglet Format > dans la zone Organiser, cliquer sur l’icône 

Aligner          > Centrer 

 Cliquer n’importe où dans la zone de dessin, mais pas sur un des rectangles > onglet Insertion 

> dans la zone Illustrations, cliquer sur l’icône Formes > sous Lignes, cliquer sur la flèche à 

deux pointes 

 Cliquer-glisser depuis le bord sous CONSOMMATEURS jusqu’au bord au-dessus de 

PRESTATAIRES DE SERVICES 

 Pour placer la flèche à gauche, comme dans le modèle, maintenir la touche Alt enfoncée et 

cliquer-glisser la flèche à l’endroit souhaité (la touche Alt évite que la flèche se relie aux 

connecteurs des rectangles) 

 Clic droit sur la flèche > Format de la forme automatique > onglet Couleurs et traits > 

modifier l’épaisseur de la flèche et le style de flèche 

30. INSÉRER UNE FORME AUTOMATIQUE 

Problème :  Comment créer l’étoile avec le texte DISTRIBUTEURS dans mon schéma ? 

Solution :  Onglet Insertion > dans la zone Illustrations, cliquer sur l’icône Formes > sous Étoiles et 

bannières, cliquer sur Explosion 1 

 Cliquer-glisser de façon à dessiner une forme comme dans le modèle > clic droit sur la forme 

>  Ajouter du texte > saisir : DISTRIBUTEURS 

 De la même manière insérer la forme automatique            (catégorie Flèches pleines) 

 Pour modifier la taille de la forme, faire cliquer-glisser les poignées bleues et pour modifier 

une partie de la forme (le rectangle ou les pointes de la flèche), utiliser les poignées jaunes 

31. FAIRE PASSER UN DESSIN À L’ARRIÈRE PLAN 

Problème :  Je remarque que dans le schéma original que je cherche à reproduire, les branches de l’étoile 

passent sous les zones de texte CONSOMMATEURS et PRESTATAIRES DE SERVICES. 

Comment obtenir le même effet ? 

Solution :  Clic droit sur un des traits de l’étoile > Ordre > Mettre en arrière-plan 
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32. REDIMENSIONNER LA ZONE  DE DESSIN 

Problème :  Mon schéma est terminé, mais la zone de dessin dans laquelle j’ai dessiné s’avère trop grande 

Solution :  Clic droit n’importe où dans la zone de dessin, mais pas sur une des formes > Ajuster 

33. CRÉER UN INDEX 

Problème :  Je veux réaliser à la fin de mon document un index afin de faciliter pour le lecteur la recherche 

de certaines notions importantes 

Solution :  Ctrl+Début (pour revenir au début du document) > dans la première ligne de l’introduction, 

sélectionner crise économique > onglet Références > dans la  zone Index, cliquer sur Entrée 

 Dans la fenêtre Marquer les entrées d’index cliquer sur Marquer tout 

 Si nécessaire, déplacer la fenêtre Marquer les entrées d’index, pour pouvoir sélectionner, dans 

le même paragraphe, marasme > Alt+Maj+X > Entrée 

 Marquer ainsi encore trois autres mots  

 Fermer la fenêtre Marquer les entrées d’index 

 Ctrl+Fin (pour se placer tout à la fin du document) > Ctrl+Entrée (pour insérer un saut de 

page) > saisir : INDEX > sauter une ligne > (onglet Références)> dans la zone Index, cliquer 

sur l’icône Insérer l’index > onglet Index > Formats : Recherché > OK 

 


